Installation Organizer
Websense® Web Security

sense and Web Filter

Use this Organizer to prepare for the installation and setup of v7.0 of Websense® Web Security or Web Filter, and
to verify that your network is properly prepared for an installation. This guide helps you gather hardware, network and
deployment information that is needed when you install the product.

This document discusses preparation for installing and configuring:

= Web filtering checklist
m  Stealth mode NIC
m  Reporting checklist

For specific deployment instructions for networks of all sizes and traffic loads, see the Deployment Guide for Web
Security and Web Filter. This document is available at: www.websense.com/SupportPortal/.

Websense products are installed using the Websense Setup program, which is downloaded from the Websense
Web site at www.websense.com.

Each Websense product includes several modules, which also contain separate components. Setup can be used
to install modules or single components on separate machines.

Web filtering checklist

1. Software prerequisites

Some or all of the following software may need to be running in your network prior to installing Websense software:

[0 Integration product: Your integration product (such as a firewall, proxy server, or network appliance) must be
installed and running before you attempt to install Websense software. Check the Deployment Guide for
supported versions. If you intend to use the Stand-Alone Edition, no integration product is required.
Integration
Version

Directory service: If you are using a directory service, such as Active Directory® or Novell® eDirectory™, to
identify users, the directory service must be installed and configured properly.

Adobe Acrobat or Acrobat Reader: You must have Adobe® Acrobat® or Acrobat Reader® software
installed to view the Deployment Guide, the Installation Guide, and the supplements for each.

NetBIOS: Logon Agent uses a logon script to identify users transparently. If you plan to use Logon Agent,
client workstations must have NetBIOS for TCP/IP enabled and the TCP/IP NetBIOS Helper Service running
(Windows® 2000, Windows XP, Windows Server® 2003, and Windows NT® only).

Internet access is required on machines where the Websense Filtering Service is installed:

] Internet access: For the Websense Master Database to download during installation, the machine on which
the Filtering Service is installed must have Internet access to the download servers at the following URLS:
= download.websense.com
m ddsdom.websense.com
= ddsint.websense.com
= my.websense.com
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2. Network considerations

See the Deployment Guide for more information on the Websense components described in this section.
[0 The machine that is filtering, i.e., running Websense Filter Service, must be able to communicate with the
integration partner, and communicate with Websense Network Agent.

Network Agent software monitors all Internet traffic on the machines assigned to it, and captures data about
bandwidth usage. Network Agent filters protocols, and integrates with proxy servers, network caches, and
firewalls.

Multiple installations of Filtering Service may be needed in distributed networks.

[0 Network Agent must be deployed where it can see all internal Internet traffic for the network segment that it is
assigned to monitor.

Multiple installations of Network Agent may be needed in distributed networks.

[0 Wwebsense User Service must be able to communicate with the Window’s directory service, if one is installed.
User Service is generally installed on the same machine as Websense Policy Server. It communicates with
the directory service to apply filtering policies to Internet requests based on users, groups, domains and
organizational units.

3. System requirements
See the Deployment Guide for detailed system recommendations for hardware, software and operating systems.

Operating systems

Windows
[0 windows Server 2003 (Standard or Enterprise), with or without Service Pack 1, or R2

Linux®

[0 Red Hat Enterprise Linux AS, ES, or WS v3
[0 Red Hat Enterprise Linux AS, ES, or WS v4
[0 Red Hat Enterprise Linux AS, ES, or WS v5

Hardware

These recommendations are for networks of about 1000 users, in which the Websense filtering and reporting
components are installed on separate machines. See the Deployment Guide for recommendations for larger
deployments.

Windows or Linux filtering components

These components include Filtering Service, Policy Broker, Policy Server, User Service, Network Agent, and the
transparent identification agent including DC Agent (Windows only), Logon Agent, eDirectory Agent or RADIUS
Agent.

[0 Quad-Core Intel Xeon processor, 2.5 GHz or greater

1 2GB of RAM

[0 10 GB of free disk space

Note that some of these components may be installed on separate machines, depending on your network
configuration and volume of Internet requests.
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Windows reporting components
Websense Manager, Log Server, Log Database, Microsoft SQL Server 2005/2000 or MSDE.*

[0 Quad-Core Intel Xeon processor, 2.5 GHz or greater
[l 4GBRAM
[0 100 GB of free disk space

Linux reporting components
Websense Explorer for Linux, Log Server, Log Database, MySQL 5.0.*

[0 Quad-Core Intel Xeon processor, 2.5 GHz or greater
[J 2GBof RAM
[0 80 GB of free disk space

* An existing, supported database engine, running on a separate machine, may be used.
4. Installation information

Identify the machines in your network on which Websense components will be installed. You must install Websense
software with a logon account that has system administrator privileges (domain and local). Note that Filtering
Service, may be installed on the same machine Policy Server and Policy Broker. Some deployments may require
multiple Policy Servers

Filtering Service machine Policy Broker/Policy Server machine

Machine name Machine name

IP address IP address

User name User name

Password Password

Port Port (default: 55806)

Additional Policy Server (if applicable)

Machine name

IP address

User name

Password
Port (default: 55806)

Network Interface Cards (NICs)

In machines containing multiple NICs, the installer asks you to select an interface for Websense communications.
Network Agent (if installed) uses this NIC to send block messages and communicate.

You may select the same NIC for each task.

[J  Nic #1—L] Communication NIC [ Monitoring NIC
Description IP address

[J  Nic #2—L] Communication NIC [ Monitoring NIC
Description IP address
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Additional Network Agents

If the configuration of the network requires multiple Network Agents, ensure that the machine on which each
Network Agent is installed can see all of the Internet requests on the segment which the Network Agent is assigned
to monitor. See the Deployment Guide for more information on deploying multiple Network Agents. See the
Websense Manager online help system for instructions on setting IP ranges.
[0 Network segment to be monitored:
IP address range: to
Network Agent machine name
IP address

[0 Network segment to be monitored:
IP address range: to
Network Agent machine name
IP address

[0 Network segment to be monitored:
IP address range: to
Network Agent machine name
IP address

[0 Other networks or machines to monitor

Additional Filtering Service

If the configuration of the network requires multiple Filtering Services, ensure that every Filtering Service machine
can communicate with the machine on which Policy Server is installed.
[ Filtering Service #1

Machine name

IP address
O Filtering Service #2

Machine name

IP address
[0 Filtering Service #3

Machine name

IP address

Subscription Key

If you have a valid Websense subscription key or 30-day evaluation key, you will enter it in Websense Manager to
allow you to download the Websense Master Database. Downloading the Master Database enables Websense
software to begin filtering immediately.

] Subscription key
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Transparent Identification Agent

If you want to identify users transparently when they make an Internet request, so they are not prompted to log on,
you must select and install a Websense transparent identification agent. See the Deployment Guide for more
information on deploying and combining transparent identification agents.

m eDirectory Agent: identifies users transparently with Novell eDirectory.
DC Agent: identifies users transparently with a Windows-based directory service (Active Directory or
NTLM).

= Logon Agent: Works with a logon script to identify users transparently when they log on to a Windows
domain. You must deploy a logon script to all client computers in your Windows network.

=  DC Agent and Logon Agent: You can choose to install both DC Agent and Logon Agent. This
deployment increases the accuracy of user identification in some networks.

[0 DC Agent must have administrator privileges on the domain to retrieve user information. Provide logon
information for the domain controller.

User name Password

[ eDirectory Agent must have administrative privileges on the Novell eDirectory Server. Provide logon
information for the Novell eDirectory Server in your network.

Distinguished name Password

[0 Logon Agent’s logon script requires the IP address and Logon Agent’s port number of the machine on which
it is installed.
IP address Port number (default is 15880)

5. Determine where to locate the installation files

[0 Accept the default location:
Windows—C:\Program Files\Websense Linux—opt/Websense
[0 Choose another location

6. Initial Setup

After Websense software has been installed, you can begin filtering with the Websense default policy settings after
installation, some initial setup is required. You will need to launch the Websense Manager and create a password
to use when connecting to the Policy Server. Proxy server information is also needed, where appropriate. This
information is needed to configure the Master Database download and the Network Agent. Network Agent must be
configured to monitor the desired traffic. If you are installing Logon Agent, you will need machine information for
use in the client logon script.

For specific instructions, refer to the Websense Manager online help system and Quick Start Tutorial. See the
Installation Guide for instructions on launching Websense Manager.
Websense Password

Your password must be between 4 and 25 characters. This password will be used for the default Websense User
Name, WebsenseAdministrator.

[0 Websense password

Websense Web Security and Web Filter » Pageb5 « v7.0-2008-09-24



sense Installation Organizer

Proxy Servers

Master Database Download

Some or all of the following information is necessary if you must authenticate to, or pass through, an upstream
proxy server to download the Websense Master Database from the Internet.

Machine name

IP address

User name

Password

Port number (default is 8080)

OoOoaoad

Network Agent
You will need the IP address of any proxy/cache server used by the machines that each Network Agent monitors.

[0 Network Agent Communication NIC'’s IP address
Proxy server’s IP address

[0 Network Agent Communication NIC's IP address

Proxy server’s IP address
[0 Network Agent Communication NIC’s IP address
Proxy server’s IP address

Enter the networks to monitor (when Network Agent is installed)

When Network Agent is installed, you must define the networks and individual machines from which to detect
traffic. (Network Agent is installed with the default installation.) See Additional Network Agents, page 4.
Ports that integration product scans for HTTP traffic (when Network Agent is installed)

If Websense software is installed with an integration product, and Network Agent is also installed, you must
configure Network Agent to not filter the ports that the integration product scans for HTTP traffic. (Network Agent
can send log records for these ports to the Filtering Service for some integrations that do not log bytes.)

[0 Ports that integration product scans for HTTP traffic (default is 80, 8080)

Stealth mode NIC

NICs used for monitoring Internet requests can be set to stealth mode, if the machine has multiple NICs. The
multiple NICs are detected during the Websense installation, so this configuration needs to be completed before
running the installation program. Stealth mode means the NIC has no IP address and cannot be used for
communication. Security and network performance are improved with this configuration. Removing the IP address
prevents connections to the NIC from outside and stops unwanted broadcasts. Make sure that you know the
configuration of all NICs in the machine before beginning an installation.

Configuration for stealth mode is done using the Windows Network Connections dialog box.
1. Select Start > Settings > Network and Dial-up Connection.
A list of all NICs active in the machine appears.
2. Select the NIC you want to configure.
3. Select File > Properties.
A dialog box displays the connection properties of the NIC you have selected.
4. Clear the Internet Protocol (TCP/IP) checkbox.
5. Click OK.
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Reporting checklist

The following checklist is designed to help you before and during your the installation of Websense reporting
components. For detailed installation instructions, refer to the Websense Installation Guide for reporting on
Windows, and the Websense Explorer for Linux Administrator’s Guide for reporting on Linux.

7. Determine how you want to deploy the Reporting components

The various components of Websense reporting may be installed on the same or different machines, depending on
the network, database engine, and operating system. Websense Manager runs reports in Windows, and
Websense Explorer runs reports in Linux.

The Log Server, Log Database, and the database engine can be installed on the same machine. If necessary, you
can install Log Database and on a machine separate with a new or existing database engine.
[0 Log Server: Required to receive, store, and report on Internet activity.

Machine name

IP address

Note
Log Server, the database, and the database engine are required to run reporting.

Database: Required storage for data about Internet activity.
Database Engine: Windows—either Microsoft SQL Server 2005/2000 or MSDE. Linux—MySQL 5.0
If you are using Microsoft SQL Server 2000 or 2005, you must perform the installation steps in a specific

sequence to avoid installation problems. Before installing in a SQL Server 2000/2005 environment, see the
Websense Installation Guide.

[0 Microsoft SQL Database Engine (MSDE) is not installed with Websense software. To use MSDE, you
can obtain English or foreign language versions from Websense. See the Websense Knowledge Base
for a link and instructions.

[ Database machine, if separate:

000

Machine name
IP address

See the Websense Deployment Guide for information on deployment recommendations.

8. Keep in mind

[0 The following services (Websense components) must be running during the reporting installation.

Filtering Service

Policy Broker

Policy Database

Policy Server

User Service

[0 1f you change default port numbers when installing Websense Web filtering software, write them down. You
may need the information when you install reporting.
Port #

[0 1f your Web browser has strict settings for pop-up blocking, it may restrict or prevent the use of some reporting
features or components.

OoOoood
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1 If you are running a Windows 2003 operating system, apply the Microsoft Windows 2003 Service Pack 1 (SP
1) before downloading the Websense Language Pack during your Websense non-English installation.

[0  If you install Log Server on the same machine as Microsoft SQL Server and later upgrade SQL Server, the
changes may prevent Log Server from starting. You may need to uninstall and reinstall Log Server.

9. Using Websense Setup to install reporting components

The Websense Setup program used to install the filter components is also used to install the reporting components.

Important

For performance reasons: Websense recommends that you do not install Websense
filtering components on the machine running reporting components.

10. Verify that you have the appropriate software and hardware

Websense components can be distributed across multiple machines, depending on the operating systems and the
size of the network.

[0 Reporting components rely on Websense filtering components. Install Websense Web Security and Web Filter
v7.0 before installing reporting components.

[0 Ensure that the machine or machines that you have selected meet the hardware, operating system, database
engine and related software recommendations listed in the Deployment Guide.

11. Verify and record the Policy Server location

[0  Verify and record the IP address or machine name where Policy Server is installed during the Websense
software installation.

] Provide the port number Policy Server uses to communicate. The default port number is 55806. Select a
different port number for Policy Server if the default port is not available

12.Provide database engine location and decide how to connect to the Database

[ Record the IP address (preferred) or name of machine running the database engine (Microsoft SQL Server
2000/2005 or MSDE).

[0 When the database engine (Microsoft SQL Server 2000/2005 or MSDE) is located on a remote machine, the
default location for installing the database file is C:\Program Files\Microsoft SQL
Server\Mssgl\Data, which works properly unless SQL Server 2000/2005 or MSDE was installed with an
instance name. If this is the case, enter the name of an existing directory on the remote machine where the
database should be installed.

[0 Make note if a Trusted Connection is being used.

Note

Websense, Inc., recommends against using a Trusted Connection when connecting to
an MSDE database.
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]  Enter the user name and password that will be used to access the database.
1 User name
For MSDE, use the gauser user name.
] Password

[0 Provide membership for the public and SQLAgentUserRole roles in the Microsoft SQL Server 2005 ‘msdb’
database. See Configuring Microsoft SQL Server 2005 user permissions in the Websense Manager on line
help system.

13. Determine where to install the database

[J Log Server and the database engine on the same machine: Click Browse to select a folder on the local
machine for installing the database.

[0 Log Server and the database engine on different machines: Enter the path for installing the database. This
must be a local drive on the SQL Server machine, and the directory must already exist on that machine.

Important

You need to create a path to the database before installing reporting components. A
problem can occur during installation if the path is nonexistent, and the Log Server and
SQL Server are on different machines.

[0 Make sure there is enough free disk space on the specified drive for each database. Also refer to your
Microsoft documentation. Keep in mind that depending on the number of users in your enterprise and your
network setup, your database may grow rapidly. For recommendations, see the Websense Deployment
Guide and it supplements.

14.Choose whether to minimize your database size

[0 websense Manager can report a separate Internet access for each Web page generated by a URL request
(visit) or for each separate file that a page request generates (hits).

Accept the default to log Web page by Visits to report by Visits for a smaller database and faster reporting.

Choose to report by Hits to record an entry for every single file requested, including graphic images and
advertisements.

[ Choose to Consolidate Log Records to minimize your database size by combining multiple visits by the same
user to the same Internet domain.

See the Websense Installation Guide for more information on these settings.
15.Determine where to locate the installation files

[0 Accept the default location
Windows—C:\Program Files\Websense Linux—/usr/local/websense/UNIXExplorer

[0 cChoose another location

Websense Web Security and Web Filter » Page9 « v7.0-2008-09-24



	Installation Organizer
	Web filtering checklist
	1. Software prerequisites
	2. Network considerations
	3. System requirements
	Operating systems
	Hardware

	4. Installation information
	Filtering Service machine Policy Broker/Policy Server machine
	Additional Policy Server (if applicable)
	Network Interface Cards (NICs)
	Additional Network Agents
	Additional Filtering Service
	Subscription Key
	Transparent Identification Agent

	5. Determine where to locate the installation files
	6. Initial Setup
	Websense Password
	Proxy Servers
	Enter the networks to monitor (when Network Agent is installed)
	Ports that integration product scans for HTTP traffic (when Network Agent is installed)


	Stealth mode NIC
	Reporting checklist
	7. Determine how you want to deploy the Reporting components
	8. Keep in mind
	9. Using Websense Setup to install reporting components
	10. Verify that you have the appropriate software and hardware
	11. Verify and record the Policy Server location
	12. Provide database engine location and decide how to connect to the Database
	13. Determine where to install the database
	14. Choose whether to minimize your database size
	15. Determine where to locate the installation files



